
Drawing Area and Precision
CorelCAD allows you to work in metric or imperial units and provides automatic conversion between different 
types of units. This feature allows you to enter metric measurements into an imperial drawing or import imperial 
objects into a metric drawing. Because of the conversion feature, there is a limit to the size of the CorelCAD 
drawing area.
The CorelCAD drawing area is 100 million units wide, 100 million units deep, and 100 million units high. A unit in 
this case refers to the smallest unit of precision. For example, if you are working in inches and have set the level 
of precision to two decimal places, the largest object you can draw is one million inches and the smallest is 
1/100th of an inch. If you change the precision to three decimal places the largest object you can draw is 
100,000 inches. But you will now be able to draw an object as small as 1/1000th of an inch.
It is not likely that you will ever need to exceed the limits of the drawing area. For example, if you require 4 
decimal places of precision (1/10,000th of an inch), it is unlikely that you will also have to draw an object that 
exceeds 10,000 inches.
The only time you might exceed the limit is if you zoom in to an object and then continue zooming in closer and 
closer. When you try to zoom in to an area smaller than the smallest possible unit, the zoom feature will not work
properly.
If you exceed the upper or lower size limits determined by your Precision settings, one or more of the following 
things might happen:
· your cursor might disappear when you bring it over the drawing surface
· your    cursor might jump around the screen when you zoom in close
· marquee selection might not work properly
· selection of objects might become difficult
Any of these problems can be solved by increasing or reducing the Precision specified in the Units and Angles 
dialog box. However, you can avoid exceeding the size limits by choosing a level of precision appropriate to your 
drawing.



Setting a point off the default drawing plane
When drawing a 3D object in CorelCAD, the cursor will be fixed to a default two-dimensional drawing plane, 
determined by the view. To draw or to set a point off this default drawing plane, the CTRL+SHIFT keys must be 
used in conjunction with the mouse. For example, to draw a 3D box you must first click a point on screen to set 
the base point. Drag the mouse to create the outline of the bottom of the box, then holding down the mouse 
button, press SHIFT+CTRL while dragging the mouse to create the height of the box. Refer to the section called 
“Drawing a 3D Box” in the CorelCAD Tutorial manual for further information.



Refinements setting and display quality
The Refinements setting under the View menu will allow you to control the quality of the display of your model 
within CorelCAD. A low value will reduce the number of surfaces and edges used to represent your model on 
screen, allowing faster redraw. A higher value will give you a better representation of your model, but will 
increase the time needed to redraw the model on screen. It is recommended that you keep the value set 
between 1 and 7 when creating your model and when saving as 8, 9, 10 cause an increase in open times, and 
increase to between 8 and 10 when rendering. 



DWG and DXF filters
DWG

The DWG filter included in CorelCAD will support DWG files up to and including Release 13 of AutoCAD. In certain
cases however, if there is no equivalent entity in CorelCAD, the AutoCAD entity will be ignored during import. 
Examples of    unsupported entities include MTEXT, MLINES and REGIONS. In some cases, saving the DWG file in 
AutoCAD as Release 12 will convert the entity into an acceptable format for import into CorelCAD. The Tech 
Support Help file will detail what is not supported by the filter. 

DXF

The DXF filter in CorelCAD will support Release 12 entities only. Some AutoCAD Release 13 entities may not be 
supported by the DXF import filer.



Default and Custom Materials
The default materials that ship with CorelCAD can be altered. Changes    to the default materials are recorded 
within the DEFAULT.MAT file. Changes to these defaults will affect the    rendering of files which used the material 
before the changes. The CorelCAD file does not keep the details of the materials used in your drawing, the file 
records    the name of the material only. If that material is modified, the next time you render files with the same 
material, the file will display with the current settings. It is recommended that you create a new material before 
making modifications.

Since the details regarding custom materials are not saved with the CCD file, such files may not render correctly 
on other systems. To view the custom materials in a file on another system, it will be necessary to bring your 
DEFAULT.MAT file to the system receiving the file. The MAT file can be placed anywhere on the hard drive, use the
LOCATE PROJECT MATERIAL FILE button under Tools, Options to locate the file. It is not recommended however, to
place the new DEFAULT.MAT file in the CUSTOM folder, as this will overwrite your original version.



Rendering
Rendering highly reflective materials on a black or very dark background may produce unexpected results. Since
the background color is taken into account when rendering, a highly reflective surface may reflect so much black
that it may disappear from the rendering. In these situations, change to a lighter background or lower the 
amount of reflectivity on your model.

When using the Render Shadows switch with the higher quality render modes, under certain lighting situation 
you may notice a striping effect on your model. If you notice this effect, modify the softness value on the 
Shadows tab in the Shade dialogue, and render again. The effect will be different depending on the lighting of 
your model, the material used, and the settings under Shadows.

Objects created on the Default layer, will render black until a color or a material is added to the objects. All 
objects will render with the current layer color (the default being black), until a color or material is applied to the 
object.

Complex drawings or drawings which have a large number of filets may not render using Hidden Line. If this 
occurs try reducing the refinements setting.



Perspective and focal length
In CorelCAD, it is possible to change the focal length of your view in order to increase the perspective of the 
model. You can perform this operation manually by typing in the values in View, Viewer Settings, or    by holding 
the CTRL key down while using the 3DView tool. Any exaggeration of these values may create a distorted 
appearance for the model, and could cause you to lose your position within the drawing. In this case, you must 
reverse your movement with the 3D View tool, or close the drawing and reopen.

When adding large amounts of distortion on a model by modifying the focal length, you may notice a 
discrepancy in size and position between the wireframe and the rendered versions of the model. Lowering the 
amount of distortion by modifying the focal length will minimize the effect.



Non recordable script commands
Some CorelCAD commands are not recordable within Corel SCRIPT. Commands such as Trim and Extend are not 
recordable because of the complexity of the operations.    The CorelSCRIPT On-Line Help will indicate which 
commands are recordable. 



Lines
You can not changes the line width on dotted or dashed lines. You can change the line width on continuous lines 
only.

Line styles may appear differently on your printed page than on screen. This is a function of the printer driver 
you are using.



Dimensions
Dimension text is not editable. Dimensions do not export from CorelCAD.

The units used for dimensioning will not update when changing the unit of measure under Tools, Units and 
Angles unless the Dimension Roll-up is open.

X and Y axis dimension can be created in Front and Perspective views only. Z axis dimension can be done in Front
and Perspective views only. Free dimensions will allow you to apply dimensions on all axis, regardless of the view.



Layers
Names for layers and layer groups are case sensitive. Layers do not sort alphabetically, but rather in the order in
which they are created.

When grouping objects on separate layers, all objects in the group will be moved to the current layer. CorelCAD 
does not support grouping over multiple layers.



Printing
When printing a rendered or hidden line view from CorelCAD, some screen operations may require the drawing 
to be re-rendered before printing the same drawing over again. Certain operations, such as clicking a screen 
point will leave the rendered view on screen, but will cause the printing of a wireframe view even though the 
rendered view is still on screen. It is recommended to re-render the drawing after making any changes to the 
drawing before printing, even if it appears that the rendered view is still intact on screen.

CorelCAD does not support multi-page files. The setting in the standard Windows Print dialogue to allow multi-
page printing will be grayed.

Printing a color drawing from CorelCAD to a black and white printer will cause colored areas and lines to print as 
grayscale. In certain cases, it may be desirable to print all colored lines as black (a floor plan for example). To 
print colored lines as black (and vice-versa) the following settings may be modified in the CorelCAD.ini file. The 
default setting for black and white printers is for all colored lines to print as black, and for colored printers is for 
all colored lines to print in color. To change the setting, open the CorelCAD.ini file in WordPad and change the 
value. Save the file and relaunch CorelCAD.
[Printing]
ColorPrintersPrintAllBlack=0
MonoPrintersPrintAllBlack=1



Hot Boxes
Certain dialogue boxes behave as "hot boxes" in CorelCAD. Hot boxes are dialogues that submit focus to the 
drawing screen when the mouse moves from the dialogue to the drawing screen. This type of dialogue will allow 
you to bring focus to a dialogue by simply dragging your cursor over top of the dialogue, allowing you to mix 
data entries in the dialogue, with selection using screen points. The default settings in the CorelCAD.ini are 
indicated below, where 1 indicates behavior as a hot box, and 0 means that the behavior is disabled. To change 
the behavior, open the CorelCAD.ini file using WordPad and change the value (to 1 or 0). Save the CorelCAD.ini 
and relaunch CorelCAD. The tolerance setting lets you determine the sensitivity at which focus changes between
the dialogue box and the drawing screen.

[HotBoxes]
HotTolerance=60
InsertPointRollup=0
MoveCommandBox=1
DimensionRollup=1
ObjectRollup=1
OtherCommandBoxes=1



Complex objects and load time
You may experience an increase in the time needed to open files which include a large number of faceted objects
(such as spheres or hemispheres). When these objects are used in files in which refinements are set to a high 
value, the increase in the number of facets used to make up these objects will cause an increase in the 
complexity of the object. Reading the complex objects will result in an increase in the time needed to open the 
file.



Norton System Doctor
We have experienced some problems when running CorelCAD at the same time as Norton System Doctor for 
Windows 95. If possible, it is recommended not to run this application at the same time as CorelCAD.



Scripts: Overview
Corel SCRIPT is an OLE enabled programming language that is used by many of the products in the Corel family. 
An updated version is included with CorelCAD. Some samples of Corel SCRIPT generated applications are 
included in the CorelCAD box. These scripts are located in the COREL\CAD1\CAD folder. Using    Customization a 
button can be created on the toolbars to access these scripts. Check the On-Line Help for full details on creating 
applications using Corel SCRIPT.



CommandLine.CSC
This script duplicates the command line interface common in other types of CAD programs. Several of the 
commands available in CorelCAD can be accessed by using command entries in the script dialogue. Note that 
when the script is running, you can not use mouse clicks for setting screen points, all entries must be command 
line driven.
The commands included in the script (and alternate keyboard shortcuts) include:
ARC (A)
ARRAY (ARR, AR)
BOX (B, BO)
CIRCLE (C, CIRC, CIR, CI)
COLOR (COL, COLO, COLOUR, CHANGE, CHANGE COLOR)
CLOSE (CL)
CONE (CO)
COPY (COP)
CYLINDER (CY, CYL)
DEFINE (D, DEF)
DELETE (DEL)
DESELECT ALL (DE, DES, DESELECT)
DUPLICATE (DU, DUPE)
ELLIPSE (E, EL, ELL)
EXIT
EXPLODE (X, EX, EXP, EXPL)
EXTRUDE (EXT)
FRUSTUM (F, FR, FRU)
GROUP (G, GR, GRO, GROU)
HEMISPHERE    (H, HEMI)
HIDDEN (HIDE, HI)
LIST (L)
LINE (LI, LIN)
MOVE (M, MO, V)
NEW (N)
OFFSET (O, OF, OFF)
PASTE (PA, PAS)
POLYLINE (P, PO, POLY)
POLYGON (POLY, TRIANGLE)
QUIT (Q)
REDO (R, RE, RED)
REFRESH (RE, REF)
RENDERED VIEW (REN, REND, RENDER, RENDER VIEW, SH, SHADE, SHADE VIEW)
SCALE (S, SC, SCA)
SELECT ALL (SA, SE, SELECTALL, SELECT)
SPHERE (SP, SPH)
TORUS (T, TO, TOR)
UNDO (U, UN, UND)
UNGROUP (U, UN, UNG, UNGR, UN GROUP, UN-GROUP)
WIREFRAME (W, WI, WIRE)
ZOOM ALL (ZA)
ZOOM OUT (ZO)
ZOOM PREVIOUS (ZP)



ZOOM TO SELECTED (ZS, ZOOM SEL, ZOOM SELECTED)



MovieScript.csc
This script uses CorelCAD and Corel PHOTO-PAINT 6 to generate an AVI file of a rotating model. Corel PHOTO-
PAINT 6 must be installed on the system for this script to operate.
The script will render separate views of the rotating model, will export each view to a bitmap format, and will 
open the bitmaps in Corel PHOTO-PAINT 6 to assemble into an AVI movie file. The script allows you to set the 
path for the creation of the AVI file, the number of frames desired, the axis of rotation as well as the quality of 
the rendering for the model. 
To set the center of rotation for the model, the Use Zoom To Fit For Render or Use Coordinate control may be 
used. If the model is of a very regular shape, Use Zoom To Fit For Render maybe be used. With this method, after
the model is rotated it is fit to screen before the export of the frame. For better results however, the Use 
Coordinates control is recommended. In this case, indicate the center point of the model (using XYZ 
coordinates). (Hint: check the Engineering Properties of your model using the Tools, Measure menu item to find 
the model’s center of gravity. Use this value for the coordinates)
Once the AVI file is generated in Corel PHOTO-PAINT 6, the resulting AVI file can be distributed and played using 
the Windows Media Player. 
Suggestion: Once the AVI file has been generated in Corel PHOTO-PAINT 6, click on SAVE AS and resave the file 
using the Compression switch. This will generate a smaller file than what is allowed through Corel PHOTO-PAINT 
6’s scripting commands.



ObjectCounter.csc
This script illustrates the use of Microsoft Visual Basic with CorelCAD. This CorelCAD script will launch a Visual 
Basic program which counts tagged objects in a CorelCAD file.
To assign a tag to an object in CorelCAD, click the right mouse button on the object to access the Properties 
menu item. On the General tab of the Properties dialogue, there is an item called Tag. Assign a tag for the object 
by typing in a name in this box. Once all objects have been tagged, run the script, and click the COUNT ITEMS 
button. A list will be generated giving the tags assigned to the objects, and the number of instances in the file. 
The list can be placed on the clipboard using the COPY button, or create a TXT file by using SAVE. This script is 
handy for creating a database of named objects within a CorelCAD file. 
Note that when you are creating an Array or Duplicating a named object, the object tag is assigned to all the 
newly created entities as well.

Other sample scripts may be included in the COREL\CAD1\CAD folder.



Ftpsend.csc
This script will allow you to send your CorelCAD generated models directly to a service bureau for 
stereolithography. Create your model in CorelCAD and save the file. Run the script to send the file directly 
through to your output service using Internet FTP (File Transfer Protocol). These bureaus are equipped with 
stereolithography machines to produce a solid version of your computer model. A list of available bureaus is 
available within the script. Contact the bureau of your choice for information on available materials, pricing and 
delivery.
To run this script, you must have access to an FTP provider, and you must have the TCP/IP Protocol setup on your
system. To add the FCP/IP protocol, follow the instructions in the Windows On-Line Help.



Aborder.csc
This script draws Imperial and Metric title blocks for standard sized paper. In the script dialogue, you can enter 
the details, and the script will create the title block as described.



Using hidden CAD views in Print Space
A useful feature in Print Space is the menu item View, Hide All CAD Views. When this option is turned on, all CAD 
frames in Print Space will suppress the OLE link to CAD. This means that you can layout your drawings without 
having to wait for the OLE links to update. If you don't have this option on, then every operation that you do in 
Print Space will trigger an OLE update, which can slow you down considerably.
With all CAD views turned off, you can still set up your CAD frame settings by right-clicking on the frame and 
selecting Properties from the pop-up menu. In the View tab of the Properties dialog box you can select Update 
Preview, and all settings will be shown in the preview box. This allows you to see what your frame will look like, 
without having to activate your CAD frame on the Print Space drawing page.
Once your layout is complete, and you are ready to print, click View, Show All CAD Frames. All OLE links will be 
refreshed. 



Difficulty Selecting Objects
If you experience difficulty selecting objects in CorelCAD, you might be trying to work outside of the boundaries 
of your world size, or your Selection Tolerance setting might be too low.
1. From the Tools menu, click Layout, Units and Angles, and adjust your precision one or two decimal places 

higher (e.g. if it's 0.00, change it to 0.0000).
2. If that doesn't work, from the Tools menu, click Options, and change the selection tolerance. The default 

selection tolerance is 5. Try changing it to 10.



A CAD Frame in Print Space must have a border to print
A CAD graphic will not print from Print Space unless the CAD frame has a border. If you don't want a border to 
appear around a frame, create an empty box with a white outline and place it over the frame.



How to import a CorelCAD model into Corel DREAM 3D 7
Before you create a CorelCAD solid model for exporting to DREAM, you should set the drawing precision to two 
decimal places.

To set the drawing precision in CorelCAD
1. In CorelCAD, click Tools, Layout, Units and Angles.
2. In the Units tab of the Units and Angles dialog box, make sure the Precision is set to two decimal places (0.00).
After you have completed the CorelCAD solid model that you want to export to DREAM, export it to DXF format.

To export your CorelCAD model to DXF format
1. In CorelCAD, Click File, Export. 
2. In the Save As Type box of the File Export dialog box select AutoCAD DXF Files (dxf).
3. Give the DXF file a name.
4. Click the Export button.
5. In the Export Options dialog box make sure the following options are enabled and all others are disabled:

Solids
Surfaces
Export objects to unique layers
Export closed polylines as faces
Set the Decimal Place Precision box to 2

To import the DXF file into Corel DREAM 3D
1. In Corel DREAM 3D 7, click File, Import.
2. In the Import dialog box, select the DXF file that you just exported from CorelCAD and click Open.
3. In the Options dialog box leave the default settings as they are and click OK.
The DXF file will now be imported into your Corel DREAM scene.




